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What is db Reports?

db Reports is a general purpose report writing application. The report files saved by 
this product are templates describing how to display the data. It is similar to a mail 
merge with a word processor. You have the data and you have the template describing 
where to place the data.

db Reports expects to get data from a database that supports SQL. A single query is 
sent to the database and a report is generated from the returned data set. The data set 
can be from one or more tables.

Current data sources supported: 4D, mySQL, ODBC, OpenBase, Oracle, 
postgreSQL, REAL Database, and Valentina. As the product matures, more data 
sources will be supported.

Report files are saved as XML files by default. Optionally, they can be encoded and 
password protected.

REALbasic® developers can download tools for printing reports from their 
programs.

System Requirements

Power PC Macintosh with at least 8 MB application memory available. MacOS 8.5 
or higher is recommended.

Different data sources have different requirements:

4D requires 4D Server 6.5 or higher.

ODBC requires an ODBC manager and drivers to be installed. These are not provided with this package.

Oracle requires OCI Shared Libraries and SQL*Net to be installed. These are not provided with this package.

mySQL requires shared libraries that can be acquired here: http://www.lilback.com/macsql/

REALbasic is a registered trademark of REAL Software, Inc.
XML processing is done with XML Toolkit 1.1 by Amar Sagoo

http://www.lilback.com/macsql/


Registering Your Product

This product is fully featured with one exception: without a serial number you 
cannot save reports.

To register your product go on line to http://order.kagi.com/?FGF and purchase a 
serial number.

Once your serial number has been e-mailed to you, select “Register” from the apple 
menu and enter your serial number.

Creating A Report

To begin the process of creating a new report, select “New” from the File Menu. db 
Reports automatically guides you through 6 steps in creating a report that will fit most 
needs.

These steps are: Set Database, Add Tables, Add Fields, Group Records, Sort 
Records. These steps are outlined in the next several pages.

You can click on the Finish button at any time to create a report based on the 
settings you have completed. Except for adding fields, all of these steps can be done 
from the Data Menu too.



Selecting A Database

From the Source popup menu, select the source type. Additional options may be 
needed depending on the source type. If they are needed, then the fields will become 
available.

Click on the right arrow at the bottom right of the window to open the database and 
continue on to the next step. See sample window below. (Your screen image may look 
slightly different based on the appearance theme you are using.)



Adding Tables

Drag tables you wish to use over to the Tables Used listing or double-click on them. 

As additional tables are added to the Tables Used listing, you need to specify how 
the tables relate to each other.  A dialog for setting this relation will show.

Do not rely on automatic relations if your data server provides this feature. db 
Reports does not recognize them. If you need data from more than one table, you must 
make sure you include them in your report.

The table just added is on the left, and others used are on the right. Select the fields 
that should match from each listing. To change the table your newly added table 
should relate to, select it from the popup menu.



Adding Fields

In this dialog drag fields over to the Use These Fields list or double click on the 
fields you want to include in the report.

Fields are placed on the report in the same order they appear in the Use These 
Fields list.

As with all the dialogs in creating a report, fields can be removed from the list on 
the right by simply clicking on one or more entries and hitting the delete key on your 
keyboard.

db Reports will add fields until it hits the maximum page width. This page width 
may be the landscape width. If fields appear to go off the page, then go to the file 
menu and select “Page Setup”. Select landscape orientation. This will allow the fields 
to fit onto the page.

If the maximum page width is reached before all the fields are added, then db 
Reports will stop adding fields.



Grouping Records

You want to group data when you want to guarantee the order and optionally 
show subtotals. 

For instance if I am looking at all items purchased for the day I may want to group 
by invoice # and sum up the total of the items per invoice. Alternately, I may want to 
group by item # and get sub totals of each item so I can see how well an item’s sales 
are.

The Group Records dialog shows two lists. On the left are all fields available. Select 
one that you want to group data by. (Usually one on the report). On the right is a list 
of numeric fields that are in the body of your report. Select one to have a subtotal field 
automatically put onto the report for you.



Sorting Records

If you previously set a record grouping then there will be some items in the Sort By 
column that are in bold. These items cannot be deleted. They are necessary for the 
record grouping to work properly.

Drag columns you wish to sort by over to the Sort By column or double-click on 
them.



Now click on the “Finish” button to create the report.

Limiting Records

Most times you don’t want everything in your database. Instead, you want only a 
subset. To define what you want, select Limit Records from the Data menu. Set the 
field, operation and field contents and click on the Add button to add this condition to 
the list of conditions.

Dates are formatted differently for different databases. Check with your database 
vendor on how to format dates.

Conditions added are AND conditions. Each condition must be met for the records 
returned. To give flexibility, there is also an OR button provided for you.

Additionally, you can set the maximum number of records that are used by the 
report.



Adding Objects To Your Report

At this point, your report may look something like this.

db Reports tries to make the fields wide enough to fit your data. To do this, it checks 
the first 100 records of your data set to create fields that are wide enough.

You can see that it also added a page footer for printing the current date and page 
number. 

To add objects to the report, select a tool from the tools palette and then click and 
drag in the editor to place and size the object. Or, if you prefer, simply drag an object 
to the report page.



After you have placed the object on the report, the selection tool is automatically 
selected for you. However if you click back onto the same tool then db Reports will lock 
the tool for you. After placing the object onto the report the selection tool will not be 
selected again. Instead, you can continue placing objects of this type onto your report. 
To get the selection tool again, simply click on it.

Above is a picture of the tools palette with the selection tool selected and a picture 
of the tools palette with the expression tool locked.

Special symbols you can use in the expression editor are: “##” for current page 
number, “//” for current date, a comma (,) to separate expressions with a space in the 
output, or a semi-colon (;) to put a new line between expressions in the output.

Objects on the report can be moved and resized like in any other drawing program. 
To aid you in the layering and centering of objects, the layout palette is provided for 
you.

An object can be added to one of various bands in your report. A band tells when to 
print the objects it contains. All objects above the band indicator belong to that band.

The report header band is printed only once at the beginning of your report. The 
page header band is printed at the top of each page. The body band is printed once for 
every record in your data set. The page footer band is printed at the bottom of every 
page and the report footer is printed once at the end of the report.

Additional header and footer bands are created for each record group you add. You 
can add additional groupings by selecting “Add Record Grouping…” from the Data 
menu.

By clicking and dragging a band you control the amount of vertical space it takes up 
on the page.

If you want a summary report that doesn’t print a line for every record, then 
remove all objects from the body band and move it up until it meets the band above it. 
This create a zero size band that won’t take up space.



Object Properties

When an object is selected, the properties window updates to show what properties 
can be set or changed.

If an expression object is selected, then a list of available field names will appear in a 
popup menu to the right of the text entry field. A calculation popup is also be 
available.

The calculation popup is very handy when your expression object is in a data 
grouping footer. With it you can do various calculations on a given field.

Use the format property to set how numbers are printed:

# digit place holder
0 place holder for digit, prints a 0 if no digit present
. place holder for the decimal point
, place holder for the thousands separator (, and . prints according to your 

particular computer’s number control panel settings)
% displays the number divided by 100



Report Properties

When no object is selected, the properties window updates to show properties of 
the report itself.

As you can see in the picture below, there is a grid section. Items placed, moved or 
resized with the mouse are constrained by this grid when Snap To Grid is selected.

The numbers at the top under Object Type are the page size in points. (Currently all 
measurements are in points, this will be updated very soon.)

By default, reports are saved as XML files. If you do not want this, then click on the 
Encode File checkbox under the Protection section.

If you don’t want others to easily edit your reports then put in a password. This 
field is only available if Encode File is selected.

If the user opens a password protected report, there are no objects shown. Instead 
they are presented 3 buttons: Preview, Print, and Unlock. To unlock and edit the 
report, they must know the password.



Previewing Your Report

To see what your report will look like, select Preview from the file menu. This opens 
another window with a preview palette. Using this palette you can go to the first page, 
previous page, next page, or last page.

In the text field you can enter a page you wish to see and then click on the 
magnifying glass button.

Click on the printer button to print a copy of the report.

While the preview window is open, you can bring the report window to the front 
and make changes. When you bring the preview window to the front again, it will 
update itself to reflect changes made to the report.



Advanced Expressions

So far you have used the automatic report generator to create your report. db 
Reports has the ability to do much more.

In the properties window, when you have a expression object selected, next to the 
Expr textbox is a popup menu. From this menu you can select an option called “Edit 
Expression…”

Selecting this menu item will give you the expression editor. Expressions can range 
from simple mathematical items such as “Items.rate*items.qty” to more complex 
expressions that include boolean, string, and math.



Expressions are fully recursive. That means if you use the if function, for example, 
another if function can be used in the true or false parameters. You can use any 
function as a parameter of any other function. This gives great flexibility in your 
options.

The maximum length of an expression at this time is basically 255 characters. 
Clicking on the Validate button will tell you if your expression is valid, has a problem, 
or is simply too complex (too long).

Using expressions allows great flexibility in what you can do with your report. The 
following page shows some examples.



Thank you for using db Reports. I hope you enjoy using it and can get what you 
need from it. At this time, all support is done by e-mail.

support@abdatatools.com

Requirement: If qty > 100, print the qty field in red.

Step 1. Make an expression object with red text and this expression: if(items.qty > 
100,items.qty,"")

Step 2. Make an expression object with black text at the same position on the report 
form with this expression: if(items.qty <= 100,items.qty,"")

Step 1 will print the qty in red only if the qty is > 100. Step 2 will print qty in black if  
the qty <= 100.

Requirement: Use these fields: people.last, people.address_1, and people.zip to print 
two strings that can be used on checking for duplicate postal addresses.

Make an expression object with this expression: people.address_1, people.zip

Make antoher expresison object with this expression: people.last, 
left(people.address_1,12), people.zip

Requirement: If qty is less than 5, print “Min Qty not met”. Show a 10% discount if 
qty is over 50.

Expression: if(items.qty < 5,”Min qty not met”, if(items.qty > 50, items.rate * 
items.qty * .9,items.rate*items.qty))

mailto:support@abdatatools.com
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